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Welcome to the world's
. No.1 weekly digital
photography magazine.
If you're already a
reader, thanks for your continued
support and involvement; if you're
new to Photography Week, you've
come to the right place! In addition
to expert advice, brilliant tips and
step-by-step tutorials, every issue
features interactive galleries of
brilliant photos, how-to videos on

0 FINE-ART MASTERPIECES

E CLUB...

essential shooting and editing
techniques, and in-depth reviews
of the latest camera Kit.

But that's not the whole story.
Photography Week is more than
a magazine - it's a community
of like-minded people who are
passionate about photography.
To get involved, just follow any
of the links below and share your
shots and comments.

Jeff Meyer, Editor

JOIN THE PHOTOGRAPHY WEEK
COMMUNITY AND START SHARING!

QOO

FACEBOOK

http://bit.ly/39py9lg b

TWITTER

FLICKR

nttp://bit.ly/2vGadLP http://bit.ly/2VIgs]0

We're more than just a magazine - read on and discover the many

ways you can interact with

and enjoy Photography Week
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WHAT' S HOT

THE WEEK'S TOP HEADLINES IN PHOTOGRAPHY

TTARTISAN UNVEILS A BUDGET
TREAT FOR DSLR SHOOTERS

Popular astro lens gets new mount options, including Nikon F and Canon EF

TArtisan has added several

new mount options to its

budget-friendly 500mm /6.3,
including DSLR options - a rarity when
most camera and lens brands are
focusing primarily on mirrorless

The TTArtisan 500mm /6.3

Telephoto lens is an affordable super-
telephoto astrophotography lens that
was launched last year, and which is
already available for Sony E, Nikon Z,
Canon RF and L mount. TTArtisan has
now made the lens available for Fujifilm
X and GF, and, more surprisingly, for

Nikon F and Canon EF mounts as well.

It may be a clever move by TTArtisan,
as there is still a market for DSLR
lenses, and astrophotography is a genre
for which the DSLR format remains
relatively popular.

The 500mm f/6.3 has proved
popular with existing users, offering
big performance at an affordable entry
point, a specialty of TTArtisan lenses.
It's a manual-focus super-telephoto
lens with a constant aperture of f/6.3.
Constructed of eight elements in five
groups, with extra low-dispersion glass,

it's marketed towards wildlife and

astrophotography.

It's notable that there's also a new GF
mount option. The GF mount is designed
for the Fujifilm GFX system, which has
a larger medium-format sensor, and
a common theme with lenses that
offer multiple-sized sensor options is
vignetting at the larger end. However,
sample images from the 500mm /6.3
show no vignetting at infinity, which is
great news for GFX users.

The TTArtisan 500mm /6.3 is
available now, priced at £409 / $329.

© TTArtisan



HOW TO MASTER THE
ART OF LANDSCAPES

Discover how to shoot and create eye-catching images with 11 inspiring
projects for taking your scenics to the next level words by: jon Adams and Andrew sames

landscape photograph is deeply If you imagine a moment where a

satisfying. But attaching a ‘fine bunch of keen photographers arrive
art’ label to it introduces an extra element | at the same great viewpoint, there's a
that will distinguish it from a typical good chance that they will all capture
landscape image and elevate it into similar-looking shots. So the question
something that can be viewed again is: what can you do to make your shot
and again, standing the test of time. This | stand out from the rest, and earn the
timeless quality is what will make us want | ‘fine art’ label?
to frame the image and hang it on the This will usually come down to two
wall, as it evokes something deeper and factors: either the way you position

@ apturing and editing a great more compelling than just a pretty view.

and set up your camera to shoot, or

the choices you make afterwards in

the way you process the files you've
captured. The mysterious ‘extra element’
you need is hard to pin down, so we've
devised a series of projects and ideas
that will inspire you to seek it out, and
produce landscapes with a different
feel to those that are ultimately destined
to find themselves consigned to the
‘pleasant-but-disposable’ category.




OEG®OLVERE
1 CAPTURE EPIC COMPOSITIONS

Take a step back, and compose your scene before you press the shutter

reasons why this image works..

efore we get into the different techniques you
can use to produce stunning fine-art shots of
landscape scenes, it's worth going over some
the essentials of photography that will stand you in
good stead. The basic principle of considering your
composition carefully before pressing the shutter
will help to elevate your captures. Below are three
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PRO ADVICE THREE TIPS FOR SUPERB SCENICS

FOCAL POINTS

At your location, study the scene so that
you can find focal points to base your shot
around. Here, note the triangulation of focal
points: the two stones in the foreground were
chosen as the main focal point of the photo; as
a long exposure was envisaged, it was evident
that the water would look dynamic around
these stones.

COMPOSITION

This image is a great example of using the
rule of thirds to good effect. As seen above,
the horizon and the two stones neatly fit into
a rule-of-thirds grid, making this image well
balanced. Many cameras have a rule-of-thirds
grid overlay in their viewfinders, which is a very
useful feature for photographers who shoot
landscape scenes.

TRY AN ULTRA-WIDE

An ultra-wide-angle lens

can add dynamism to your
landscapes. Technically
‘rectilinear’ lenses, they're
designed to keep lines straight
for the most accurate rendition.

Captured with a Canon EOS 5D
Mark lll and Canon EF 14mm f/2.8L
IlUSM lens at a low angle on a
tripod, this carefully composed
image also benefits from a long
exposure to create movement in
the water, resulting in a fantastic
fine-art landscape photo

e

LEADING LINES

These are important for leading the viewer
into a shot. As you can see above, the two main
rocks draw the viewer up the central axis of
the image towards the outcrop in the distance.
As well as introducing movement and action,
the use of a long exposure creates additional
leading lines in the water, helping to draw the
eye to the horizon.

© Getty
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2 FRAME LIKE AN ARTIST

Think of a scene as a selection of shapes, and
arrange them with careful camera positioning

Taken in Namibia, with the sun low

in the sky, this mono image was
enhanced in raw processing to boost
the contrast, to reveal the shapes in the
scene and create a full range of tones

brief glance through a variety of ‘classic’ landscapes will reveal that

they're beautifully composed, not too cluttered, and show a pleasing

balance of the key shapes within the frame. In most cases, there's
some strong foreground interest that catches the viewer's eye and leads it to
a secondary point of interest further back in the scene. This might be leading
lines that carry you into the rest of the scene, a strong foreground ‘anchor’,
such as a gnarly rock or other object, or some more delicate detail or texture
close to the lens.

When you've found one of these devices to lure the viewer into your scene,
make sure you position it so that it complements other elements in the frame,
and, if you use lead-in lines, make sure they go somewhere, and don't take the
eye out of the frame. Another vital element is the lighting - most landscapes are
taken in the hour after sunrise or the hour before sunset, when the light is warm
and the shadows are long thanks to the low position of the sun in the sky.

© Andrew James
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3 SMEAR YOUR WAY TO SUCCESS

Employ an age-old technique to add artistic blur to
a scene and conjure up a romantic, diffused mood

Give your floral scenics an arty
twist with this proven technique.
Experiment to see how you can
blur the background while
keeping the focal point pin-sharp

hile this is one of the oldest
@ tricks in the book for getting

an arty soft-focus appearance
in your images, it can still work an
absolute treat, so let's revive this tried-
and-tested technique. All you need is
some petroleum jelly (such as Vaseline)
and something you can smear it on that
will then fit over the lens. Obviously,
it's possible to smear the jelly directly
onto the glass of a lens, but this could
potentially damage an expensive
optic so is best avoided. Instead, you
could use an old UV filter that's been
scratched and is no longer in use.

Early uses of a ‘gel’ filter were to

create a softening effect for portraiture,
but this technique can work equally

well for fine-art landscapes, especially
where there's a main focal point, like a
flower, within the scene. For this poppy
shot, the camera was placed on a tripod
to fix the composition. Using Live View,
it was easy to see the effect of the gel
being applied in real time. You need to
work reasonably quickly when smearing
the lens, because the gel starts to dry
and becomes less malleable.

Small dabs of jelly gently spread
out around the poppy created extra
blurring and a slight desaturation of
the background colours, too, giving the
image a slightly surreal appearance.
This shot was taken at /5.6 but, at a
glance, you'd think it was at a larger
aperture, such as f/2.8.

HOW TO APPLY THE GEL
TO A LENS FILTER

Anold UV filter is the best option for
placing the petroleum jelly over the

lens, but you'll need some alcohol

wipes to hand to clean it off afterwards,
and to keep your fingers clean to avoid
transferring any grease to your camera
or clothes. Apply the jelly around the filter
with the tip of your little finger, leaving

a clear area where your main subject is.
Do this carefully - if you add too much,

you'll have to wipe it all off and start again.
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hoot a moving element

within your scene with a long

exposure and you'll capture
an intriguing sense of energy. This
might be a flowing stream, but even
the apparently still waters of ponds
and lakes can soften and blur when
the exposure time runs into minutes
because their surface is constantly
moving, even if you can't see it.
Within a landscape, we also have

AME

other elements like wind-blown
trees, crops, or even clouds scudding
across the sky that can be similarly

softened. To achieve a long exposure,

even in normal daylight conditions,
you need a specialist filter to hold
back light.

Neutral density filters come in
varying strengths, but for really long
exposures you'll need a 10-stop ND.
Some are circular and screw directly

éxposure
210

onto your lens (you'll need to buy
the right filter size), but others may
need a special filter mount. When
using a 10-stop ND, you must use

a tripod and cable release so the
camera isn't jogged when you take
the photo. If the exposure you get
is more than 30 seconds, you'll also
have to use the camera’s Bulb mode,
which keeps the shutter open until
you close it manually.

Here, a long exposure achieved
-step graduated ND filter



EOEDO®®
5 SPLIT-TONE A MONO SCENE

A black-and-white rendition is a surefire way to add timeless
appeal, but split-toning takes moody mono to new heights

Split-toning adds different colour
washes to the shadows and
highlights, adding extra interest
to a black-and-white photo

fter you've made a mono
conversion to give a colour
landscape an artistic appeal,
there's another processing technique
you can employ to take your photo in

a new direction. Split-toning assigns
different colours to the highlights and
shadows in your image, so instead of
applying a single toning treatment (as
you would with sepia- or blue-toning),
you can tint both tonal ranges at the
same time. Although you can use

any colour, split-toning is best when
opposite (or complementary) colours are
used. That means going for blue-yellow,
red-cyan, or green-magenta splits,

though the most successful is usually
blue-yellow, as this creates cool-toned
shadows and warm-toned highlights,
both of which are traditional treatments.
First, make a mono conversion that's
rich in contrast and detail. To do this
with a colour raw file, open the image
in Camera Raw and select the Adobe
Monochrome profile. In the Basic panel,
adjust the sliders for good contrast and
detail, then tweak the colours in the
Black & White Mixer panel to assign your
preferred grey tones to the colours in the
scene. With the conversion complete,
add your split-toning treatment to the
mono image (see panel).

© Jon Adams

PRO ADVICE
TONING IN RAW

The split-toning options can be found in
the Color Grading panel. With the Adjust
option, you'll be presented with three
colour wheels for Midtones, Shadows and
Highlights. Ignore the Midtones, and click
inside the Shadows wheel to pick a colour.
With the Shadows set (in this example) to
blue, click inside the Highlights wheel to
choose a colour for the lighter tones in the
scene (such as the warm yellow-orange
here). Now move the Balance slider below
to set the transition point between the
colours for a split-toned look.



EEOG®OVURG
6 PAINT WITH YOUR CAMERA

While it's something that photographers usually try hard to
eliminate, camera shake is the effect that's desired here

A moving camera can add eflergy
and intrigue to an image, creating an
effect akin to an impressionist painting

PRO ADVICE
SUCCESS WITH SHAKE

Getting the right combination of shake
and shutter speed involves a delicate
balance, and unfortunately there are no
hard and fast rules that you can follow, as
there are too many variables at play.

The focal length has a big impact - a
telephoto will magnify the movement and
a wide-angle lens will suppress it - so
the more you zoom out, the more camera
movement you'll need for the effect to
have an impact. Most people find that
a shutter speed of around 1/15 sec
is easier to control than slower ones, so
starting around that mark and making
more or less intense movements will
start you on the way to exploring the art

of camera movement.

t's no secret that fine-art

photography takes its cue from

the Old Masters, and although
a camera, rather than a paintbrush, is
your tool, that doesn't mean you can't
get ‘painterly’ in the way you capture.
Many artists see simplicity and a lack
of definition as a way of capturing an
impression of a scene, and by reducing
or removing the hard edges of reality,
impressionist-style pictures can be
created in-camera.

To get swirls, blurs and streaks in your
shots, move the camera at the moment
of exposure. This may be at odds with
the standard way of taking a photo,
where we aim to get the subject as sharp
as possible - but in the search for that
elusive fine-art ingredient, this technique
can be successful.

To pull off such a shot, use a slower
shutter speed than normal, and ‘jitter’

a handheld camera as you press the
shutter. The results can be hit and miss,

but by varying the shutter speed and the
amount of ‘jitter’, you can work towards a
solution that gives an arty rendition of a
scene without the detail normally seen.

Although the technique is similar to
the one used for blurring trees (see the
next page), the camera movement used
is different, and can vary from roughly
circular sweeps to a deliberate shake. To
see how well it has worked, always zoom
in on the screen and inspect the hard
edges in the shot - these will reveal the
type of motion that you've captured.

To set up for a jitter shot, use Aperture
Priority mode and dial in the smallest
aperture available (usually f/22). Now set
the lowest ISO value (usually 1ISO100) and
your camera will set the slowest possible
shutter speed for the light conditions.
Start your intentional camera jitter, then
press the shutter button, continuing the
movement until the shutter closes. Check
the screen, then reshoot with different
amounts of jitter or a different aperture.

© Getty



Use vertical intentional camera movement for magical tree images

OEOO®OLVRE
/ TILT FOR TREES

eliberately moving
the camera up and
down during the

exposure to create ‘streaking’
abstract trees is an easy
way to create something
visually arresting. For this
intentional camera movement
(ICM) technique, you need a
shutter speed of about 1/15
sec and a smooth camera
action. The most important
part is finding the right trees
in the right light. If the trees
are tonally similar to the
background, the image can
look muddy and unappealing.
Instead, find strong shapes
and good contrast - tall,
thin-trunked trees are best,
and, where possible, have
light-coloured trees against a
dark background or dark trees
against a bright background.
Framing your shot with
a moving cameraisn't a
precise skill, but having some
ground in the frame gives
the composition a base,
and a receding line of trees
accentuates depth. This

technique works with any lens,

but a short telephoto lens in
the 70-200mm range will help
you pick out an interesting
section of woodland. The
trick is to keep the camera
movement smooth, so repeat
the up-and-down camera
movement until it feels
natural. Press the shutter after
you've started the movement,
taking care not to jerk the
camera with your shutter
finger, and take multiple shots
before checking the results.

Smoothly moving the camerain
an upward or downward motion
during the exposure will create
an arty, streaked effect

© Andrew James



OEOO®OLVRE
& ADD ATMOSPHERE WITH FLARE

Add some extra sparkle to fine-art landscapes
with an in-camera starburst effect

hotography tradition dictates
shooting with the sun behind
your shoulder so that you're
capturing your subject with the light
falling directly onto it. While this
approach usually makes sense, try
going against the grain and shooting
into the light. This is also known as
‘contre-jour’, which means ‘against

the day’. Shooting like this can be
challenging, as it's easy to end up with
an image that's too dark, so you may
need to dial in some positive exposure
compensation to brighten your shot.

To achieve the starburst effect, you'll
need to use a small aperture, such as
f/11, as this helps to control the light. The
small aperture only allows a narrow hole

for the sunlight to pass through, and
this causes the light waves to spread
out and create the starburst effect.

The exact pattern you get is
dependent on the number and design
of the aperture blades inside the lens,
but as a general rule, a wide-angle lens
is the best optic to use to create this
atmospheric look.

© Andrew James



EEOG®OLVRE
9 SHOOT FOR A TRIPTY(CH

Create a visually stimulating piece of artwork that would be worthy of hanging
In a gallery, by displaying three related photos together in a single frame

ormally, we try to get
everything we want from a
scene into a single frame,

but we don't always have to take this
approach for our image presentation.
A triptych is simply three separate
images displayed together for a fresh
visual perspective. You can opt to
show part of a wider scene, and then
some of the smaller details that would
be less obvious had you chosen to
photograph the location with a wide-
angle lens.

How you creatively explore the
potential of a triptych is up to you, but
a standard approach would be to have
three vertical images displayed next to

each other, as in the below triptych of
ancient rocks in England.

As a rule, upright images are going
to work best if you want each part of
the triptych to be identical in size, so
walk around the scene picking out
various things that will work together
tonally, as this will help you to knit the
finished triptych together.

It's also likely that you'll need
to crop the original shots to make
them slimmer, and this is worth
remembering as you're composing
your pictures. Sometimes the biggest
headache you'll have with a triptych is
deciding on the sequence of the three
images you've selected, and it helps

to print out all the photos and play
around with the order until you feel
you've found a balanced composition;
in general, the most dominant shot
should be placed in the centre.

PRO ADVICE FRAME UP

In Photoshop, choose a document size
and go to View > New Guide Layout.
Select 3 columns and 1 row and set the
Margin values. With the Rectangular
Marquee tool, draw a selection within the
markings. Copy your firstimage and, using
Edit > Paste Special > Paste Into, drop it

in place, resizing it with Edit > Transform >
Scale. Repeat for the other shots.

© Roddy Llewellyn
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10 CREATE MULTI EXPOSURES

While you can achieve this effect in-camera, Photoshop layers and
blending modes let you generate arty effects from a single shot

Using three blended .':::' il 7 N e
/ers of the same - g ik - 0 N,
m@f which are Y fIZZ) @ ‘% f :
" enlarged and rotated, T AN =

:_."} l'n:*_i.:-im b T3k, Creates an indistinct

b — s S and artistic impression
> & Of a well-known

~ Venetian scene

gy ."".-_"_"’!'T.' A |
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e e e T e AW

PRO ADVICE
USING LAYERS

Making a three-layer stack of the same

|"1
'y
il

© Jon Adams

shot, and changing the size, rotation and @ lending similar shots of the box to add some rotation. Hit Return
blending mode of the top two layers, will same scene, taken from slightly to apply the changes, and then repeat
give an impressionistic rendition of the different angles, gives a unique these steps with a second layer, this time
seee A el Uunves selLstmerl ey and dramatic effect that forces the rotating it in the opposite direction. You
on top lets you control contrast. . ) . o .
viewer to do a bit of ‘mental processing can change the blending mode of one or
. to grasp the content and form of the both duplicate layers to create different
Layers image. It takes some time to achieve a effects, and you can also fine-tune the
& 1ond . EeTHnS® ® satisfying result using a camera’'s multiple  position of the two duplicate layers by
e o exposure mode, but by using layers in selecting the Move Tool, and dragging
) ) _ Photoshop you can control the outcome  the layers or tapping the arrow keys.
R B REG0K - with precision and, even better, do it with Once you have a pleasing blend,
w8 st a single source photo. It's best to use you'll need to adjust the contrast of the
: ' - a picture with strong lines and strong blended image. To do this, click on the
L | detail, such as an urban landscape, but top layer, click the Adjustment Layer
IRl Layer 1 copy once you have your starting pointonthe  icon at the bottom of the layers panel,
e screen, the process is easy. and choose Curves from the list. In the
To start, duplicate the image by Curves panel, add two points and drag to
pressing Ctrl/Cmd+J, and in the Layers create an S-curve to change the contrast.
panel change the blending mode of If you want to adjust the colour mix too,
e i a the duplicate layer to Soft Light. Now click where it says RGB and select the
© O QD E B hit Ctrl/Cmd-+T for Free Transform, pull red, green, or blue channel, adjusting the
' ] out the corners to enlarge the image curve in the same way to boost or reduce

a little, and drag outside the bounding the contrast of the selected channel.



OEOO®OLVRE
11 PRESENT YOUR PICS LIKE A PRO

Give your photos a ‘published’ appearance by mounting
them on a digital canvas and adding a title and credit

ASHNESS BRIDGE, CUMBRIA

PHOTOGRAPHY BY JON ADAMS

Printing your image
with a black border, a
title and a credit will
give it an artistic lift,

and framing it will finish
the job off in style

t shouldn't come as much is to create a new canvas in Photoshop
o of a surprise, but a well laid (to match your printer's paper size) and

out, well-presented photo then copy and paste your image into it.
gets an immediate head start on the Using the Transform command (Ctrl/
competition. It looks more considered  Cmd+T), you can adjust the size of the
and more serious, and that grabs image to suit the canvas, leaving a
attention if you're seeking ‘fine-art’ clean white margin around the edge.

status. The easiest way to achieve this By selecting the image area, you can

© Jon Adams

add a thin border via Edit > Stroke and,
if you want to give your shot a ‘poster’
feel, you can add a title beneath the
image, and even add a photographer’s
credit. If you're wondering whether a
particular shot will make the grade or
not, presenting it in this way could help
you to decide.
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THE WEEK'S MOST INSPIRING READER PHOTOS

OUTDOOR NATURE
DIRK BUSE
“I took this photo at a botanical gardens in Miinster, Germany.”

https://bit.ly/48vygKR


https://bit.ly/48vygKR

THE WEEK'S MOST INSPIRING READER PHOTOS

ROTTERDAM CRUISE TERMINAL
MARK GREENFIELD
“A fine-art photograph of the cruise-ship terminal in Rotterdam.”

https://bit.ly/3v1BEXx


https://bit.ly/3v1BExW

THE WEEK'S MOST INSPIRING READER PHOTOS

RED MUSHROOM
ALEXANDER FENZL
“I photographed this mushroom with my Nikon Z6 and 150mm f/2.8 lens.”

https://bit.ly/3lnVBry


https://bit.ly/3lnVBrv

THE WEEK'S MOST INSPIRING READER PHOTOS

THE BEECHES
NEIL SHAW
“A different take on a scene that I've photographed often. I've gone
somewhat ‘Insta’ with the processing, which seems an increasingly
common style for landscape photographers these days.”

/= .\ | PHOTOGRAPHY WEEK WANTS YOUR PHOTOS!
'., . . / Taken a portrait you're particularly proud of? Shot a sensational sunset you'd like to
\\ / show off? Then join the Photography Week Facebook community and share your best
FACEBOOK FLICKR photos today! You'll get feedback from fellow readers and the Photography Week
http//bit.y/39py0ld  http//bit.y/2Vigs10 | team, plus the chance to appear in Xposure, or even on our cover!
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THE BEST THING WE'VE SEEN THIS WEEK

Images © The photographer and courtesy International Garden Photographer of the Year

Deadvlei Pan by Robin Williams, Finalist, Plants & Planet Cosmos Apricotta’ by Molly Hollman, 2nd place, Beauty of Plants

AMAZING IMAGES CELEBRATE ALL
THINGS BRIGHT AND BOTANICAL

International Garden Photographer of the Year reveals stunning winners

nternational Garden Photographer of | featured in Japanese woodcuts”. She
0 the Year has revealed the winners of | processed the image, entitled Birdscape,
its IGPOTY 17 contest, showcasing to alter the colours and “enhance the
another spectacular selection of images of feeling of movement and sense of the
flowers, plants, gardens, fungi, woodlands, ‘birds’ dancing in a fantasy woodland”.
and just about anything else you can think of Prizes are awarded across categories
that grows. including Beautiful Gardens, The Beauty SEE MO R E IMAGES
This year's overall winner was June of Plants, and Wildlife in the Garden Click
Sharpe, for her intricate abstract image of the link to see more images at the IGPOTY
layered conifer branches, which, she says website, where you'll also find details of
“reminded me of the dancing cranes often how to enter upcoming competitions.


https://bit.ly/3v0VUA6
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ESSENTIAL PHOTO SKILLS MADE EASY

SHOOT SUPER-5HARP CLOSE-UPS

Can't get everything in focus? Adam Waring shows you how
to focus-stack images for incredible front-to-back sharpness

macro lens enables you to
focus extremely close to a
subject so that it's reproduced
at life-size on the camera
sensor, opening up a world of incredible
detail that's impossible to see with the
naked eye. The drawback is that at such
close focusing distances depth of field
becomes extremely shallow, and will

be only a matter of millimetres even if
you stop down to a harrow aperture - so
all that detail is lost from all but a very
narrow band of sharp focus.

The solution is focus stacking. Take a
series of shots, each at a slightly different
focus distance, then combine the images
to include the sharpest elements from
each shot. It sounds complicated, but all
the hard work is easily done in software,
and it's a largely automated process.

You simply focus on the closest part
of the image, take a shot, then twist the
focus ring a tiny bit and take another
shot, repeating the process until the most
distant part of your subject is in focus.
Some new cameras make things even

easier with focus shift’ shooting modes
which automatically takes a series of shots,
each at a slightly different plane of focus.
Macro photography is just one
application of focus stacking; it can be
used for any subject where you can't get
enough depth of field in a single frame,
such as landscapes in which you can't get
both distant mountains and foreground
rocks sharp without encountering
diffraction, an optical anomaly that causes
softening of images at narrow apertures.
Here's how we created the image above..




STEP BY STEP STACKING FOR SHARPNESS

1

GET SET UP

We're using a Sigma 105mm /2.8 Macro lens,
but any close-focusing lens works for this
technique - even a kit lens, which can focus at
around one-third life size. Use a tripod to keep
your camera steady, with the subject positioned
so that everything fits in the frame.

CAMERA SETTINGS

Switch to Manual mode so that each shot has
the same exposure, and set an aperture of f/11
for optimum sharpness, along with ISO100 and

a matching shutter speed. Flick the switch on

the lens barrel to manual focus, and focus on

the closest part of the subject.
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GET FOCUSED

It's best to use Live View. Zoom in to the
closest part of the subject, and twist the focus
ring until the detail is pin-sharp. Once you've
achieved focus, take your first shot - it's best
to use a remote shutter release, as at such
close distances even the slightest knock of the
camera will ruin the shot.

Focus shift shooting -

FOCUS SHIFT SHOOTING

With a focus shift mode like the one on the exact figures you'll need depends on a few 0

Nikon D850 you select the number of shots factors, including the lens's focal length,
you want and the ‘focus step width' - the how close the subject is, and your selected
amount by which the focus ring rotates. The aperture, so it's a case of trial and error.




STEP BY STEP STACKING FOR SHARPNESS

0

REFOCUS AND REPEAT

Rotate the focus ring a tiny fraction so that the
plane of focus is a little further into your subject
and take another shot, taking care not to jolt
the camera in the process. Repeat until the very
furthest part of the subject is in focus.

5

OPEN THE IMAGES

Once you've uploaded the images to your
computer, open Photoshop and go to File >
Scripts > Load Files into Stack. Click the Browse
button, select your images and click Open, then
OK. The images will be loaded into a Photoshop
document as separate layers.

hhhhh -
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BLEND THE IMAGES

Select all the layers, then go to Edit > Auto
Blend Layers. Set Blend Method to Stack
Images, make sure Seamless Tones and

Colours is ticked, then click OK. Photoshop will
now magically combine the sharpest bits of
each layer together using layer masks.

QUICK TIP

While Photoshop does a good job of focus
stacking, specialist software does it better.

Try Helicon Focus (https.//bitly/48z8btB) or
Zerene Stacker (https://bit.ly/48rYCM2Z).



https://bit.ly/48z8btB
https://bit.ly/48rYCMZ

BEFORE

HOW TO...

CAMERA RAW / LIGHTROOM
LEARN ESSENTIAL EDITING SKILLS FAST!

BALANCE YOUR WHITES

James Paterson shows you how to apply colour
shifts and fix casts in Camera Raw and Lightroom

here's more to white balance
o than simply getting the whites

balanced - it's about getting
every colour in an image right. There are
two ways you can do this: set the white
balance in-camera, or shoot in raw and
set it afterwards. Best practice is to set
it in-camera, but sometimes this isn't
practical. By shooting in raw, you can
leave your white balance set to Auto
WB, safe in the knowledge that you can
tweak it afterwards if necessary.

Photoshop’'s Camera Raw and

Lightroom offer near-identical white

balance tools, which you'll find in the
Basic panel in Camera Raw or in the
Develop module in Lightroom. The tools
are simple to use, but there are some
essential tricks that can help you get the
most out of them, which you'll learn in
this issue’s video tutorial.

One of the great things about white
balance tools is that you can use them
selectively in different areas of the
photo. With a landscape like the one
above, it means we can pull out a touch
of warmth in the sky while also fixing
the image’s overall cool cast.

WATCH THE VIDEO
https://bit.ly/49qWeXS

EXPERT TIP

Sometimes it can be tricky to
determine the right white balance
settings, especially if there isn't

an obvious neutral area to sample
with the Eyedropper Tool. If you're
struggling, a handy trick is to
temporarily take the Saturation

and Vibrance sliders all the way to
100%. This can make it much easier
to assess the balance of colours,
and determine whether the image
is too warm or cool (in which case,
tweak Temperature) or too green or
magenta (tweak Tint). Once you're
happy, double-click the Saturation
and Vibrance sliders to reset them.


https://bit.ly/42OqFou
https://bit.ly/49qWeXS
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EXPERT OPINION ON THE LATEST KIT

HASSELBLAD
907X & CFV 100C

A camera system that's not just beautiful but versatile, too

he Hasselblad 907X and
o CFV 100C is quite simply the

most beautiful camera system
I've seen. I'm a sucker for vintage
cameras and SLR-styled modern
mirrorless models, but I've never been
quite as smitten with the design of a
camera as with this one.

This beauty is also a beast,
however. A truly unique modular
system, the Hasselblad 907X &

CFV 100C comprises a ‘camera’ -

the 907X - and the all-new 100MP
medium-format back - the CFV 100C.
Combined, they become a modern

lwww.hasselblad.com| £6,729/58,199

mirrorless camera, but the CFV 100C
can also be attached to a vintage
Hasselblad body, such as the iconic
500C, adding 100MP horsepower to
these similar systems.

The camera is a huge step up
in performance over the previous
Hasselblad 9o7X and CFV 50C (the
older 50MP digital back). That's
because, inside, it has a lot in common
with the Hasselblad X2D 100C, hamely
the 100MP sensor and phase-detect
autofocus system with face detection.

However, the X2D is a conventional
SLR-style camera, so the 907X &

CFV 100C have as many differences
as similarities. So who is this combo
for, and does an old-fashioned box-
style camera still have a place in the
modern world?

Features

The most obvious feature of the
camera is its jaw-dropping design - a
palm-sized, perfectly sculpted square
body that eschews a viewfinder and
ergonomics in favour of a tilting
screen and touch-oriented inputs.
However, this is more than just an
aesthetic affectation. This is a modular


http://www.hasselblad.com

MEDIUM-FORMAT CAMERA TEST HASSELBLAD goy7X & CEV 100C

1 The most obvious feature of the camera is
its jaw-dropping design - a perfectly
sculpted square body.

2 The CFV 100C instantly transforms an old
200 or 500 camera into a 100MP mirrorless
powerhouse.

3 From the tactility of the exposure dial to
the shutter button, the whole systemis a
marvel of precision.

& An optional optical viewfinder can be
attached, though the system is intended to
be used via the screen.

5 The shutter is located in the bottom corner,
where your finger sits as you hold the
camera in hand.

6 The 3.2-inch rear screen’s 2.36 million dots
and 24-bit colour show off the glorious
colour depth and tonality of its images.

1 There are five buttons at the bottom of the
screen, but the system is designed to be
driven by touch.

The 100MP resolution offers so much
flexibility in terms of editorial framing,
shooting in different aspect ratios, and the
ability to artificially extend focal length

camera system that consists of two
parts: the wafer-thin 907X ‘camera’ (a
mount adaptor to attach XCD lenses
to the camera back) and the CFV
100C digital back, which contains the
100MP image sensor, processor, rear

screen, controls, battery and memory.

Inside the CFV 100C is the

| same 100MP sensor and phase-

5% %% S99 a9

detect-powered autofocus system
as the Hasselblad X2D. The new
907X combo delivers the same
performance as the X2D, but with
additional versatility due to the
modularity of the system. With the
CFV 100C and 907X, you can mount
the modern mirrorless X System
Hasselblad lenses (along with HC/

© James Artaius
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MEDIUM-FORMAT CAMERA TEST HASSELBLAD goy7X & CEV 100C

The 907X/100C has no stabilisation; however,
if your work demands a more measured
approach, such as product photography, then
this is less of a disadvantage

HCD, V and XPan glass via adapters).

However, you can also attach the
CFV 100C to technical cameras and
Hasselblad’s legacy V System film
medium-format cameras, including

The incredible 100MP sensor produces
pin-sharp images, but this resolution will
instantly betray even the merest hint of
laxness in your camera discipline

the 500 and 200 series.

Like the X2D, this system has a
single CFexpress Type B slot (which
supports cards up to 512GB) along
with a built-in 1TB SSD, good for

© James Artaius

around 4,700 raws, 4,000 raw + JPEG
sets, 28,000 JPEGs, 4,300 raw + HEIF
sets, or 53,000 HEIFs. Thanks to their
leaf shutter design, Hasselblad XCD
lenses support flash synchronisation
at all shutter speeds, which is handy
for the studio shooting that this
system caters for. A feature you won't
find, however, is video; no one buys

a Hasselblad because they want to

shoot a vlog, but it's worth mentioning.

Build and handling

The build quality of the 907X/100C is
as premium as the design. From the
locking mechanism that connects the
body and the back, to the irresistible
tactility of the exposure dial and
shutter button, the system is a marvel
of precision. While there are five
buttons at the bottom of the rear
screen, the camera is designed to
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MEDIUM-FORMAT CAMERA TEST HASSELBLAD goy7X & CEV 100C

The images are sublime, as always from Hasselblad. As well as
tonality and colour, there's so much richness and depth packed

into the files, and the highlights and shadows sing

—
-
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“THE CAMERA'S MOST OBVIOUS
FEATURE IS ITS JAW-DROPPING
DESIGN — A PALM-SIZED, PERFECTLY

SCULPTED SQUARE BODY"

be driven by touch - and
Hasselblad's menu system and
touch interface are unparalleled.
Like a minimalist, upmarket version
of Apple’'s UX, this is the most
luxurious way of changing ISO or
adjusting your screen brightness.
The rear screen is a 3.2-inch affair
with 2.36 million dots and 24-bit
colour to display the glorious colour
depth and tonality of images.
Given that the combo is designed
to be used like a classic top-down

camera with a waist-level ‘finder,

such as the Hasselblad 500C, the

touchscreen tilts, with hard stops

at 40 degrees and 90 degrees.

An optional optical viewfinder can

be attached, though the systemis

intended to be used via the screen.
The ergonomics are modelled after

classic medium-format ‘box’ cameras

- which is to say, this isn't a camera

designed for handheld shooting,

though it fits in the palm. The shutter

is located in the bottom corner,

© James Artaius

where your trigger finger sits as you
hold the camera in your hand, and is
surrounded by the knurled exposure
dial. These are the only direct controls
on the camera itself, though XCD
lenses have a customisable control
ring to add an extra exposure function.
A beautiful-looking grip is available
for dedicated handheld shooting. But
while the grip feels great and works
well, this camera is to made be used
on a tripod rather than handheld -
particularly since it lacks any in-body
image stabilisation, Besides, that
100MP resolution will instantly betray
even the merest hint of laxness in
your camera discipline.

Performance
The 907X with CFV 100C delivers

genuinely incredible image quality,
with unrivalled tonality and colour



© James Artaius
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The 907X & 100C demands a considered
approach rather than rapid-fire SLR-style
shooting. As such, it's tailor-made for

landscapes, still life, product photography
and studio portraiture

depth. Hasselblad's Natural Colour
Solution technology means that hues
and tones ‘pop’ in a way that adds
greater dimension to your subjects.
Of course, this being the same sensor
that's found in the Hasselblad X2D,
you can expect the same 16-bit
colour and 15 stops of dynamic range
- along with the same phase-detect
autofocus system that finds focus
fast and reliably.

While the camera’s sensor and
AF system are carried over from the
X2D, something that hasn't been
transplanted is the seven-stop image
stabilisation system. The modern
Hasselblad demands a deliberate,

SENSOR: 100MP BACK-SIDE ILLUMINATED
(MOS MEDIUM-FORMAT LENS MOUNT:
HASSELBLAD X SYSTEM AUTOFOCUS:
HYBRID PHASE DETECT WITH 294

PDAF ZONES IMAGE STABILISATION:

NO ISO RANGE: 64 TO 25,600 VIDEO:

NO VIEWFINDER: NO LCD: 3.2-INCH,

2.36 MILLION-DOT TILTING (40°, 90°)
TOUCHSCREEN MEMORY: INTERNAL 1TB
5SD, 1X CFEXPRESS TYPE B (UP TO 512GB)
MAX BURST: 3.3FPS (14-BIT COLOUR)
CONNECTIVITY: WI-FI 6, BLUETOOTH,
USB-C 3.1 GEN2, SHUTTER CONTROL PORT,
FLASH SYNC INPUT, FLASH SYNC QUTPUT,
ELX OUTPUT, OPTIONAL HOT SHOE SIZE:
102 X 92 X 84MM WEIGHT: 620G (907X

& CFV 100C ; EXCLUDING BATTERY AND
MEMORY CARD)

"HUES AND TONES ‘POP’ IN A WAY
THAT ADDS GREATER DIMENSION
T0 YOUR SUBJECTS”

considered approach rather than
rapid-fire SLR-style shooting. As

such, the 907X / 100C is tailor-made
for landscapes, still life, product
photography, studio portraiture, and
any situation where the camera can
be set up stationary for measured,
precise work. That said, it's also a
formidable street shooter when paired
with a monopod.

Image quality, as always from a
Hasselblad camera, is sublime. In
addition to the tonality and colour,
there's so much richness and depth
packed into the files that highlights
and shadows simply sing, and there'is
also latitude in the dynamic range to
work with. Then there's the resolution;
it's easy to forget how much flexibility
100MP gives you, and not just in terms
of framing, or being able to shoot in
aspect ratios like XPan (65:24), but
also in the ability to artificially extend
your focal length.

James Artaius

VERDICT

The Hasselblad 907X & CFV 100C
is a truly unique camera system
with a miraculous 100MP sensor;
but, given its various limitations -
lack of viewfinder, ergonomics or
stabilisation - why would anyone
pick the 907X & CFV 100C over
the Hasselblad X2D? If your work
requires the use of a tripod, then
these limitations don't matter
so much, and while there's no
escaping the fact that it costs an
incredible amount of money, the
Hasselblad 907X & CFV 100C is the
ultimate medium-format camera. If
your work is studio or tripod-based,
this is the system for you.

1 8. 8.8 & ¢

LAB TESTS

RESOLUTION (LINE WIDTHS/PICTURE HEIGHT)
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= Hasgalblad 907X & CFV 100C — Hassalblad 907X & CFV Il 50C
Fuiflm GFX 100 i — Sony Alpha aTRV

We tested the 907X / 100C against the Hasselblad 907X
/ CFV II 50C, Fujifilm GFX 100 II and Sony A7R V. The
two 100MP cameras unsurprisingly resolve almost
identical detail levels, though the GFX 100 II produces
clearer results at higher I50s, thanks to its slightly
better image noise control.

SIGNAL-TO-NOISE RATIO (oecseLs)
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The camera to beat here is the CFV II 50C, as its

relatively modest pixel count for such a large sensor
area means it has larger individual pixels, which are,
therefore, less susceptible to generating image noise.
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The CFV 100C leads the pack for dynamic range at low

IS0s, but can’t quite match the comparison cameras
once sensitivities exceed I50400.
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N-Photo is a monthly magazine for
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